SUPER DECISIONS WORKSHOP

Elena ROKOU
Creative Decisions Foundation
erokou@creativedecisions.net

About this workshop

**Goal**
- Understand how decision making is done and how and when to use different multi-criteria decision making methods focusing on AHP, Ratings, ANP and BOCR

**Communication**
- Send email for anything you need about this workshop: erokou@creativedecisions.net

**Related Books**
- Group Decision Making & Encyclicon

**Software tools**
- SuperDecisions – 6 months free license
**Workshop Summary**

- AHP models - Hierarchies
- ANP models - Networks
- Ratings = Large number of alternatives
- Structuring Complex Models with BOCR
- Optimization of resource allocation

---

**AHP**

Analytic Hierarchy Process
AHP – The idea

• The Analytic Hierarchical Process (AHP) and the Analytic Network Process (ANP) are used to measure intangibles using human judgment.
• AHP/ANP are the most powerful synthesis methodologies for combining judgment and data to effectively rank options and predict outcomes.
• These are structured techniques for organizing and analyzing complex decisions, based on mathematics and psychology. They were developed by Thomas L. Saaty.
• They have particular application in group decision making, and are used around the world in a wide variety of decision situations, in fields such as government, business, industry, healthcare, shipbuilding and education.
• Rather than prescribing a “correct” decision, these methods help the decision makers to find a solution that best suits their goal and their understanding of the problem.
• It provides a comprehensive and rational framework for structuring a decision problem, for representing and quantifying its elements, for relating those elements to overall goals, and for evaluating alternative solutions.

The Analytic Hierarchy Process (AHP)

Decision Making involves setting priorities.
Our own personal priorities with our consciously elicited subconscious pairwise comparison judgments are the most important influence on our decisions.
But we also need to creatively structure our decisions consciously to represent the important factors and criteria.
The AHP is the way to derive priorities by asking the right questions about influences in a meaningful scientific way to make decisions.
How to make decisions?

- We all make decisions all the time. To make a decision we need to:
  - Create a structure to relate all the factors that influence the outcome of that decision,
  - Provide judgments to determine the importance (priority) of these influences and then synthesize those priorities to determine the best or the most likely outcome.
  - Technically we need to measure all the tangible and intangible factors in a decision and combine them into a single final outcome.
  - Influences usually happen and pass very fast, we cannot hope to capture them and measure them that fast.
    - Also the same kind of influence has different importance under different conditions.
    - We cannot hope to assign them a number that can always be used to represent their importance.
- What can we do and how do we do it?

Deciding using AHP

- Every decision involves
  - a conscious creative structure of all the elements that influence the possible outcomes and thought and
  - subconscious judgments to compare things in pairs using the smaller one as the unit and estimating how many times the greater one is
- You need to compare within the confines of homogeneity and use pivots to reach non-homogenous alternatives or
- rate things one at a time with respect to an ideal (the ideal is always relative to one’s knowledge).
AHP is a process that requires us to:

1. Understand and define the problem as completely as possible.
2. Structure a problem as a hierarchy.
3. Elicit judgments that reflect ideas, feelings and emotions.
4. Represent those judgments with meaningful numbers.
5. Synthesize Results.
6. Analyze sensitivity to changes in judgments.

A Hierarchy

[Diagram showing a hierarchy with a goal at the top, criteria in the middle, and alternatives at the bottom]
**Tangible and Intangible Criteria**

- We need to prioritize both tangible and intangible criteria:
  - In most decisions, intangibles such as
    - political factors and
    - social factors
  - take precedence over tangibles such as
    - economic factors and
    - technical factors
- It is not the precision of measurement on a particular factor that determines the validity of a decision, but the importance we attach to the factors involved.
- How do we assign importance to all the factors and synthesize this diverse information to make the best decision?

**Objectivity**

- Bias in upbringing: objectivity is agreed upon subjectivity.
- We interpret and shape the world in our own image.
- We pass it along as fact.
- In the end much of it is obsoleted by the next generation.

*There is no objectively right and wrong decision there is only a preferred alternative solution based on the decision makers system of beliefs*
Verbal Expressions for Making Pairwise Comparison Judgments

- 1: Equal importance
- 3: Moderate importance of one over another
- 5: Strong or essential importance
- 7: Very strong or demonstrated importance
- 9: Extreme importance

2, 4, 6, 8: Intermediate values

Use Reciprocals for Inverse Comparisons

Super Decisions Terms

- **Alternative**
  - An alternative is a node representing one of the choices in a decision model. The alternatives are grouped together in a single cluster.

- **Cluster**
  - A cluster is a collection of nodes that have some logical relationship together.

- **Comparison Group**
  - Consists of a parent node linked to a group of children nodes that will be pairwise compared with respect to the parent node for importance, preference or likelihood.
  - The children nodes must be in a cluster together; the parent node may be in a different cluster or in the same cluster as its children nodes, and may have children groups in several clusters.

- **Criterion**
  - A criterion is a decision factor, something that must be considered when making a decision. A criterion is represented by a node in a SuperDecisions model.
Super Decisions Terms

- **Goal**
  - A goal in a model is a single node in a cluster with links only “from” it.
  - In hierarchical models there should be only one goal. In hierarchies criteria nodes are linked from the goal and judgments are made about their importance with respect to the goal.

- **Hierarchy**
  - In a hierarchy the goal is at the top, the criteria are in a separate cluster connected from the goal, the subcriteria are in clusters connected from a parent criterion.
  - Clusters are often arranged hierarchically with the goal cluster at the top of the window, the criteria cluster below that, the subcriteria clusters below that and the alternative cluster at the bottom.

Super Decisions Terms

- **Inconsistency**
  - If element A is preferred to element B by 2
  - and element B is preferred to element C by 3,
  - then element A should be preferred to element C by their product, 6.
  - If it is not 6, then there is inconsistency.
  - All such triples of judgments for a comparison group are checked for consistency and SuperDecisions gives a measure of the inconsistency as a decimal number that should be less than about 0.10.
**Super Decisions Terms**

- **Link or Connection**
  - A link goes from one node to another. A node most often has links to several other nodes.

- **Model**
  - A SuperDecisions model may be a simple network contained in a single window, or a complex model of 2 or 3 or more levels consisting of a main network with attached sub-networks linked together.

- **Network**
  - Any collection of clusters, nodes, and their connections in a single window (a window is a box or frame). A network may be either a hierarchy or a feedback structure.

- **Node**
  - A node is an element or factor in a decision such as the goal, a criterion, a subcriterion, or an alternative. Nodes are smaller rectangular frames inside a cluster frame.

- **Normalization**
  - Mathematical procedure of summing a group of numbers and dividing each by the sum so that the resulting numbers will sum to 1; the numbers are then said to be normalized to 1. Priorities are sets of numbers normalized to 1. To obtain priorities from any group of numbers apply the procedure above.

- **Priority**
  - Priorities result from making a set of pairwise comparison judgments on a group of children nodes. The priorities sum to 1.
Super Decisions Terms

• Sensitivity
  – To perform sensitivity with respect to a criterion in a hierarchy means to vary the priority of that node, maintaining the same relative proportion of the other nodes with respect to the goal, and see how the outcome changes.

• Supermatrix
  – the judgment data for a model is stored in supermatrices (think of an Excel spreadsheet).

• Synthesis
  – after judgments are made the model is synthesized to give the best alternative; that is, the one with the highest synthesized priority.

A Three-Level Hierarchy to Choose the Best Car

Goal
Buy Best Car

Prestige  Price  MPG (Miles per gallon)  Comfort

Acura TL  Toyota Camry  Honda Civic
The Cars

- **Acura TL**
  - Cost $30,000-$35,000
  - Miles per gallon 20/29 (City/Hwy)
  - Prestige is very good
  - Comfort is excellent

- **Toyota Camry**
  - Cost $22,000 - $28,000
  - Miles per gallon 22/30 (City/Hwy)
  - Prestige is good
  - Comfort is good

- **Honda Civic**
  - Cost $16,000 - $20,000
  - Miles per gallon 29/38 (City/Hwy)
  - Prestige is medium to low
  - Comfort is medium to low

The Decision Hierarchy as it appears in the SD Software

All links are from node to node. A link from one cluster to another is automatically created if some node(s) in a cluster are connected to some node(s) in another cluster.

See the SuperDecisions model: Tutorial_1_Acura_Relative_Model.sdm
Get it from Help>Sample Models>Tutorial Models
The Unweighted Supermatrix after all Judgments Completed

The priorities from the pairwise comparison sets are inserted into the column of the parent node.

- For example, the priorities of the criteria are in the Goal Node column.
- The priorities of the cars with respect to the criteria are in the relevant Criteria columns.

Limit Supermatrix

Final results are obtained from the Limit Supermatrix. The limit supermatrix (for a hierarchy) is obtained in the software by raising the unweighted supermatrix to powers until it goes to zero, then backing up one power. The Limit Supermatrix is displayed by the software as the sum of all the powers. It is done this way to display the priorities of all nodes with respect to the goal. To obtain the Limit Supermatrix, select Computations > Limit matrix > Graphical.

The raw values come from the Limit Supermatrix; they are the results, and the priorities of the alternative cars are obtained.
Graphical Sensitivity

1. To do graphical sensitivity select the Computations > Sensitivity command.

2. Select Edit > Independent Variable to get to the Sensitivity input selector box and change the Independent Variable to the Goal.

ANP

Analytic Network Process
Loop in a component indicates inner dependence of the elements in that component with respect to a common property.

Arc from component $C_4$ to $C_2$ indicates the outer dependence of the elements in $C_2$ on the elements in $C_4$ with respect to a common property.

**Analytic Network Process (ANP)**

- The ANP is a mathematical theory that makes it possible for one to deal systematically with dependence and feedback, and includes the AHP as a special case.
- The reason for its success is the way it elicits judgments and uses measurement to derive ratio scales.
- Real life problems involve dependence and feedback. Such phenomena cannot be dealt with in the framework of a hierarchy but we can by using a network with priorities.
- With feedback the alternatives can depend on the criteria as in a hierarchy but may also depend on each other.
- The criteria themselves can depend on the alternatives and on each other as well.
- **Feedback improves the priorities derived from judgments and makes prediction more accurate.**
AHP vs ANP

- AHP: What is more preferred or more important? Both are more or less subjective and personal.

- ANP: What has greater influence? This requires factual observation and knowledge to yield valid answers and thus is more objective.
  - Decisions with the ANP should be more stable because one can consider their effect on and survival in the face of other influences.

The questions we answer in ANP

- Given a criterion, which of two elements has greater influence (is more dominant) with respect to that criterion?
- Given an alternative, which of two criteria or properties is more dominant in that alternative?
- Given a criterion and given an element X in any cluster, which of two elements in the same cluster or in a different cluster has greater influence on X with respect to that criterion?
- The entire decision must use the idea of something “influencing” another. Otherwise it must use the idea of “influenced by” throughout the analysis as follows:
  - Given a criterion and given an element X in any cluster, which of two elements in the same or in a different cluster is influenced more by X with respect to that criterion.
Summarizing ANP

- In ANP we have criteria grouped in clusters and alternatives grouped in a cluster usually named “Alternatives”
- We can have inner and outer dependencies among the criteria, the alternatives and the criteria and the alternatives
- We can have feedback (self loop) in any cluster
- We can pairwise compare the clusters like we do the criteria and the alternatives
- The final results are given by the limit supermatrix
- We do sensitivity in the same way that we do the AHP sensitivity

Ratings
Ratings

- When alternatives are thought to be independent of one another they can be rated one at a time on each criterion.
- In that case one must be able to say how high or low an alternative rates on a criterion by allocating it to one of various intensity slots of ranking such as very high, high, medium, low, poor and so on. These slots can be different for each criterion: A, B, C for example.
- The intensity slots have numerical priorities associated with them obtained by pairwise comparing.
- To rate alternatives one must have an ideal in mind about how close or far that alternative is from the ideal for a particular criterion.
- **When using rating we don’t have rank reversals**
  - That means that adding alternatives to the model will not create changes on the relative ranks of the existing alternatives
  - In pairwise comparisons this is not the case

What are ratings?

- In AHP/ANP we have two ways of creating priorities:
  - By comparing the alternative in pairs (pairwise comparisons)
  - By RATING the alternatives one at a time with respect to an ideal or standard
    - This kind of measuring is analogous to measuring something with a physical device, like measuring length with a yardstick
- When do we use ratings?
  - When alternatives are thought to be independent of one another
    - The presence or absence of an alternative must have no effect on how one rates any of the others
  - When we can have an IDEAL alternative in mind to compare with
  - When the number of alternatives make the pairwise comparisons too time consuming
    - e.g. if we want to evaluate 50 employees, then 1,225 (50(49)/2) pairwise comparisons, would be required for each criterion if we used a pairwise comparison model and not a ratings model. But only 50 are required if you are rating them.
Ratings - Methodology

Step 1
• Create an AHP or ANP model WITHOUT any alternatives
• No alternatives cluster will appear in the model

Step 2
• Do all the pairwise comparisons needed to evaluate the criteria

Step 3
• Select the bottom level criteria to use in the ratings model

Step 4
• For each criterion define a custom scale of performance and prioritize its entries through pairwise comparing

Step 5
• Rate each alternative on each criterion by selecting the scale entry that best describes how it performs

Step 6
• Calculate each alternative's total score by multiplying the selected scale entry's priority on each criterion times the weight of the criterion and summing.

Step 7
• Idealize all results to find a performance score (out of 1.0) for each alternative and sort to get the order. A performance score of 1.0 would be a perfect score.

Ratings scales

– One must be able, by having had experience, to pick the appropriate rating intensity on a criterion for an alternative

– To do that you must have something in mind called an IDEAL so that you get the feeling about how close or far the alternative is from the ideal and allocate it to one of various intensity slots of ranking — we call them SCALES

– Scales
  • A scale is a group of rating intensities that describe levels of performance on a criterion. The rating intensities of the scale itself are pairwise compared to establish priorities once and for all.
  • For an alternative pick the rating intensity that best describes its performance on that criterion.
  • We have one scale for each decision criterion. Scales may have different numbers of intensities
  • The same scale can be used for more than one criterion in the same model
  • The same scale can be re-used in different models
Ratings – Example: Best City to Live in

Create a Ratings Model

1. Build a hierarchical model as shown below and enter judgments as before, but do not include the alternatives in the main screen of the model. The model has 4 criteria and the Comfort criterion has subcriteria of Ride and Driving Performance.

2. Select Design>Ratings to open the Ratings screen where the Alternatives will be evaluated.
**Starting Ratings**

- Click the Ratings tab to open the Ratings canvas

1. Select the covering criteria. Covering criteria are the lowest level of criteria that connect to the alternatives. For example, you should not include the Comfort criterion, but only its subcriteria of Driving Performance and Ride.

2. Create scales of performance for each of the criteria you selected.

3. Add the alternatives you wish to rate.

4. Rate each alternative as to its performance on each criterion in the Ratings table.

   - Note that you can more easily rate many alternatives than if you were pairwise comparing them. It does take more experience and expertise to rate alternatives on a criterion rather than pairwise compare them.

---

**The 4 Rating steps**

1. Select the covering criteria. Covering criteria are the lowest level of criteria that connect to the alternatives. For example, you should not include the Comfort criterion, but only its subcriteria of Driving Performance and Ride.

2. Create scales of performance for each of the criteria you selected.

3. Add the alternatives you wish to rate.

4. Rate each alternative as to its performance on each criterion in the Ratings table.

   - Note that you can more easily rate many alternatives than if you were pairwise comparing them. It does take more experience and expertise to rate alternatives on a criterion rather than pairwise compare them.
**Step 1 – Select the Covering Criteria**

1. Double click a criterion to add it. Scroll with the scrolling wheel on your mouse, or use the down and up arrows on the keyboard. Criteria that have been added appear in the second list and are colored blue in the first list.

2. To delete a criterion select it in the second list and click the Remove Criterion button.

**Step 2 – Add the alternatives**

1. Type the alternative name in the left field.
2. Click the Create Alternative button.
3. To delete an alternative select it and click Delete Alternative.
4. To edit an alternative double click it in the Current alternatives list and make your edits, then Save Edited Alternative.
5. The Copy Alternatives and Paste Alternatives copy all alternatives to the clipboard and Paste from there. Useful in complex models that have many subnetworks.
Step 3 – Create Rating Intensities

1. Select a criterion (here it is Prestige).
2. Click “Add New” button to create names of intensities for a rating scale for Prestige.
3. Click the Compare button to pairwise compare the intensities to establish their priorities. The resulting idealized priorities are used in Ratings. The largest intensity thus receives a priority of 1.0. An alternative that gets the top rating on every criterion gets 1.0 as its overall score – it is perfect!
4. If you want to re-use these intensities and priorities click the “Save to File” button and save the *.rcp file for use with other criteria.

Step 3 – Prioritize Rating Intensities

1. Click the Compare button to bring up the pairwise comparison screen.
2. Click the white highlighted comparison word area and change from Importance to Preferable.
Ratings – Make Judgments and show Ideal Priorities

1. Enter judgments – questionnaire mode appears but you can use any mode (improve consistency in matrix mode if necessary)
2. Select Computations > Ideal Priorities
3. File > Close to return to Step 3 where these priorities will appear as the intensity priorities for Prestige.

Step 3 – Save and Re-use Intensities

BUTTONS
1. Add new – Add a new intensity to the list
2. Move Up – Select an intensity and drag it up
3. Move Down – Select and intensity and drag it down
4. Load from file – Click to bring up a list of pre-defined intensities; double-click to load the set of intensities for the current criterion. Intensity files have a .rcp extension and are stored in the samples directory.
5. Save to file – Click the button and select a directory to store it in. Currently the software does not allow you to save in the Samples directory.
Evaluate Alternatives in Ratings Table

Mouse over a cell and when the pen (edit icon) appears click to display the intensities for that criterion.

Click on the one that best describes the alternative to select it.

BOCR
Benefits – Opportunities – Costs – Risk
**BOCR**

- **Benefits – Opportunities – Costs – Risks**
- In most decisions it is possible to identify the factors that offer benefits or opportunities, or have to do with costs or risks.
- The factors are best evaluated by grouping those that influence benefits together, and similarly grouping the others.
- This is done through a system of control nodes.
- The BOCR nodes are control nodes with networks beneath them that contain their control criteria nodes.
- Each of the control criteria nodes in turn have a decision subnetwork containing the alternatives of the decision.

**BOCR vs SWOT**

[Diagram showing the comparison between BOCR and SWOT]
Structuring Complex Decisions

Phase 1
- the subjective, personal, group or corporate values

Phase 2
- the interface-merits of the decision between the first (subjective) and third (objective) phases: Benefits, Opportunities, Costs and Risks

Phase 3
- the objective hierarchies and/or networks used to represent the influences that affect the ranking of the alternatives of the decision with respect to each control criterion

Phase 1 – Subjective values
- It provides the intensities on which the BOCR merits are rated one at a time during the final step of the process
- Represent personal values (similar to the ones in the Maslow pyramid)
- There are similar values for a group, corporation and for the entire world as represented for example by the United Nations

- Survival, health, security, family, friends and basic religious beliefs
- Career, education, productivity and lifestyle
- Political and social beliefs and activities
- Philosophical thoughts and ideas and things that are changeable
**Phase 2 - BOCR & Phase 3 – AHP/ANP Sub networks**

- Each of the four BOCR has a hierarchy of control criteria and sub-criteria with respect to which a decision network of influences that includes the alternatives is evaluated.

![Diagram showing decision network with criteria such as Economic, Social, Political, and Cultural]

**Structuring complex decisions**

- **Personal or group criteria for rating BOCR nodes**
  - Subjective values
  - E.g. satisfaction, prosperity, security, growth, harmony, etc.

- **The BOCR merit control nodes**
  - Link from subjective to objective values
  - Benefits, Opportunities, Costs and Risks
  - Several control criteria for each of the four BOCR whose priorities are obtained from a hierarchy or a network

- **Feedback Networks**
  - Objective values
  - Decision hierarchies/networks containing alternatives
  - One for each BOCR control criterion
  - E.g. economic benefits, political benefits, social benefits, technological benefits etc.
  - Identify the most general set of components including the component of alternatives that influence each other with respect to any control criterion
  - For each control criterion under the BOCR merits delete the unnecessary components and connect corresponding nodes with directed arcs according to influence among the resulting components
A complete BOCR model

- A complete model consists of the following parts:
  1. A Rating model of personal criteria to evaluate the importance of Benefits, Opportunities, Costs and Risks in this decision;
  2. A main control network containing the Merit control nodes: Benefits, Opportunities, Costs and Risks, to which the importance weights from the first model are applied;
  3. Subnetworks of control criteria for each of the merits;
  4. The decision subnetworks that contain other factors of the problem and the alternatives. Each control criterion has a decision subnetwork.
  5. In some complex models it becomes clear that benefits, opportunities and costs, for example, do not have equal weights in the decision. In this case it is possible to put strategic criteria in the main network to weight the BOCR.

Prioritization of complex decisions

- Identify and prioritize personal or group criteria and sub-criteria applied to all the decisions you make
- Identify and prioritize the control criteria and sub-criteria for each of the four BOCR merits
- Decision networks containing alternatives
  - One for each BOCR control criterion
  - For each network corresponding to one of the several control criteria under each merit derive priorities
- Bottom up approach
  - Synthesize from the lowest level to the BOCR levels
  - Rate the BOCR merits on the intensities of the strategic criteria
  - Synthesize at the top level to get the final results
BOCR Example
Amazon Delivery Service

Decision problem

- The question here is whether Amazon should invest towards entering the delivery industry in the US.
- If the trend of growing e-commerce and shipping costs continues, their margins will begin to diminish.
- Currently, Amazon ships primarily through UPS, with some volume being delivered by FedEx.
- With these trends and dependencies, Amazon is trying to determine if entering the delivery industry will provide revenues that will outweigh the entry costs. They want to decide which alternative will give them the most gains.
**Alternative solutions**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>do not enter the courier service industry</td>
<td>This option would require FedEx missing out on the potential gains of entering a large and growing industry. They would continue to pay shipping costs, and be dependent on UPS and FedEx to deliver on their commitments. This option provides little to no benefits or opportunities, the costs are minimal, and risks would be the costs of shipping becoming too exorbitant. This is the “do nothing” option.</td>
</tr>
<tr>
<td>create a courier service internally</td>
<td>This option requires large investment into infrastructure, staffing, and knowledge. Amazon would continue to rely on couriers while their service expanded. This option provides some benefits and opportunities in that it enters the industry and can lead to reduced costs and increased revenues. Its costs are quite large and there is the risk that the investment fails, or that delivery companies have a negative reaction to the entry.</td>
</tr>
<tr>
<td>purchase a small courier company</td>
<td>This option requires a moderate upfront investment to acquire a small courier service. Amazon would continue to rely on other couriers while the business is expanded. This option provides some benefits and opportunities in that the intellectual property and infrastructure of the courier could be utilized, and it would be a more significant entrance into the industry. This option has similar risks to creating their own courier service, larger couriers could reduce service or increase costs.</td>
</tr>
<tr>
<td>purchase a large courier company</td>
<td>This option requires a significant upfront investment to acquire a large courier company. Amazon would immediately become a major player in the industry, they would acquire all of the intellectual property and infrastructure of the large courier, and would also be able to have almost all of their volume delivered internally. The risks of this option would be Amazon’s focus may shift from their expertise, and have an adverse effect on customer the customer experience.</td>
</tr>
</tbody>
</table>

---

**Main model**

GOAL: Should Amazon expand its delivery service in the US?

<table>
<thead>
<tr>
<th>STRATEGIC CRITERIA</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>GROWTH</td>
<td></td>
</tr>
<tr>
<td>INNOVATION</td>
<td></td>
</tr>
<tr>
<td>SYNERGIES</td>
<td></td>
</tr>
<tr>
<td>REPUTATION</td>
<td></td>
</tr>
<tr>
<td>TECHNOLOGY</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MODEL</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BENEFITS</td>
<td></td>
</tr>
<tr>
<td>OPPORTUNITIES</td>
<td></td>
</tr>
<tr>
<td>RISKS</td>
<td></td>
</tr>
</tbody>
</table>
# Strategic criteria weights

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Description</th>
<th>Weight</th>
<th>Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Growth</td>
<td>Potential growth of the company</td>
<td>0.106</td>
<td>4</td>
</tr>
<tr>
<td>Innovation</td>
<td>New ways of providing services to customers</td>
<td>0.235</td>
<td>2</td>
</tr>
<tr>
<td>Inter market</td>
<td>Synergies between the delivery industry and the retail industry</td>
<td>0.054</td>
<td>5</td>
</tr>
<tr>
<td>Market</td>
<td>Attractiveness of new markets</td>
<td>0.037</td>
<td>6</td>
</tr>
<tr>
<td>Reputation</td>
<td>Impact of the decision to the company's reputation</td>
<td>0.360</td>
<td>1</td>
</tr>
<tr>
<td>Technology</td>
<td>Early adoption of new technologies</td>
<td>0.205</td>
<td>3</td>
</tr>
</tbody>
</table>

## Benefits

![Benefits Diagram](image)
Opportunities

<table>
<thead>
<tr>
<th>OPPORTUNITIES</th>
<th>ECONOMIC</th>
<th>OPERATIONAL</th>
<th>ORGANIZATIONAL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alternatives</strong></td>
<td>Markets</td>
<td>Competitive Adv.</td>
<td>Processes</td>
</tr>
<tr>
<td></td>
<td>Enter New Industry</td>
<td>Vertical Integration</td>
<td>Delivery Date Estimation</td>
</tr>
<tr>
<td></td>
<td>Increase Marketshare</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Financial</strong></td>
<td>Increase Earnings</td>
<td>Logistics</td>
<td>Structure</td>
</tr>
<tr>
<td></td>
<td>Increase Shipping Revenues</td>
<td>Home-to-supplier</td>
<td>Cross Train Employees</td>
</tr>
<tr>
<td></td>
<td>Reduce Shipping Costs</td>
<td>Return Service</td>
<td>Realign Job Positions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Warehouse-to-home Service</td>
<td></td>
</tr>
</tbody>
</table>

Costs

<table>
<thead>
<tr>
<th>COSTS</th>
<th>ECONOMIC</th>
<th>OPERATIONAL</th>
<th>ORGANIZATIONAL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alternatives</strong></td>
<td>Financial</td>
<td>Labor</td>
<td>Overhead</td>
</tr>
<tr>
<td></td>
<td>Acquisition Costs</td>
<td>Drivers</td>
<td>Hub &amp; Station Managers</td>
</tr>
<tr>
<td></td>
<td>Capital</td>
<td>Maintenance</td>
<td>Hub &amp; Station Support</td>
</tr>
<tr>
<td></td>
<td>Goodwill</td>
<td>Package Handlers</td>
<td></td>
</tr>
<tr>
<td><strong>Infrastructure</strong></td>
<td>Hubs &amp; Stations</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>IT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sortation System</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tractors</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Structure</strong></td>
<td>Added Salaries</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Employee Morale</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Overlapping Job Functions</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Risks

BOCR Priorities

Here are the overall synthesized priorities for the alternatives. You synthesized from the network Subnet under 1. Benefits: formulaic

<table>
<thead>
<tr>
<th>Name</th>
<th>Graphic</th>
<th>Ideals</th>
<th>Normals</th>
<th>Raw</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Counter Service Internally</td>
<td>0.340797</td>
<td>0.33534</td>
<td>0.340797</td>
<td></td>
</tr>
<tr>
<td>Do Not Enter Industry</td>
<td>0.520859</td>
<td>0.520859</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Large Courier</td>
<td>0.511982</td>
<td>0.511982</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Small Courier</td>
<td>0.600800</td>
<td>0.600800</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here are the overall synthesized priorities for the alternatives. You synthesized from the network Subnet under 2. Opportunities: formulaic

<table>
<thead>
<tr>
<th>Name</th>
<th>Graphic</th>
<th>Ideals</th>
<th>Normals</th>
<th>Raw</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Counter Service Internally</td>
<td>0.340797</td>
<td>0.33534</td>
<td>0.340797</td>
<td></td>
</tr>
<tr>
<td>Do Not Enter Industry</td>
<td>0.520859</td>
<td>0.520859</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Large Courier</td>
<td>0.511982</td>
<td>0.511982</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Small Courier</td>
<td>0.600800</td>
<td>0.600800</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here are the overall synthesized priorities for the alternatives. You synthesized from the network Subnet under 3. Costs: formulaic

<table>
<thead>
<tr>
<th>Name</th>
<th>Graphic</th>
<th>Ideals</th>
<th>Normals</th>
<th>Raw</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Counter Service Internally</td>
<td>0.340797</td>
<td>0.33534</td>
<td>0.340797</td>
<td></td>
</tr>
<tr>
<td>Do Not Enter Industry</td>
<td>0.520859</td>
<td>0.520859</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Large Courier</td>
<td>0.511982</td>
<td>0.511982</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Small Courier</td>
<td>0.600800</td>
<td>0.600800</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here are the overall synthesized priorities for the alternatives. You synthesized from the network Subnet under 4. Risks: formulaic

<table>
<thead>
<tr>
<th>Name</th>
<th>Graphic</th>
<th>Ideals</th>
<th>Normals</th>
<th>Raw</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Counter Service Internally</td>
<td>0.340797</td>
<td>0.33534</td>
<td>0.340797</td>
<td></td>
</tr>
<tr>
<td>Do Not Enter Industry</td>
<td>0.520859</td>
<td>0.520859</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Large Courier</td>
<td>0.511982</td>
<td>0.511982</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purchase Small Courier</td>
<td>0.600800</td>
<td>0.600800</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Results

1. Ratings: Keep the highest alternative for each merit in mind and perform ratings across the corresponding row as to how it impacts the strategic criteria.

<table>
<thead>
<tr>
<th></th>
<th>Points</th>
<th>Totals</th>
<th>Growth</th>
<th>Innovation</th>
<th>Technology</th>
<th>Reposition</th>
<th>Market Adherence</th>
<th>Interaction Efficiency</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Benefits</td>
<td>1.221342</td>
<td>1.125127</td>
<td>Excellent</td>
<td>Average</td>
<td>Average</td>
<td>Above Average</td>
<td>Above Average</td>
</tr>
<tr>
<td>2</td>
<td>Opportunities</td>
<td>0.964296</td>
<td>0.917955</td>
<td>Above Average</td>
<td>Average</td>
<td>Average</td>
<td>Above Average</td>
<td>Average</td>
</tr>
<tr>
<td>3</td>
<td>Costs</td>
<td>0.222970</td>
<td>0.224722</td>
<td>Excellent</td>
<td>Average</td>
<td>Above Average</td>
<td>Above Average</td>
<td>Average</td>
</tr>
<tr>
<td>4</td>
<td>Risks</td>
<td>0.716312</td>
<td>0.782600</td>
<td>Above Average</td>
<td>Average</td>
<td>Average</td>
<td>Average</td>
<td>Average</td>
</tr>
</tbody>
</table>

1. Additive negative formula – generally best for long term results: \(bB + oO - cC - rR\)
2. Multiplicative formula – equivalent to marginal cost/benefit analysis and generally best for short term results: \(BO/CR\)

---

### Skeletal Outline of Networks in a BOCR Model

- **Level 1 - Main network**: BOCR (main network)
- **Level 2 - Control Criteria Hierarchies**: Benefits, Opportunities, Costs, Risks
- **Level 3 - Alternative Subnets**: Alts, Alts, Alts, Alts, Alts, Alts, Alts, Alts

- In this schematic there are 17 networks in all:
  - a main network at the top that has a cluster containing the BOCR nodes,
  - 4 control criteria networks each containing
  - 3 control criteria nodes, and
  - 12 alternative subnets, one for each of these nodes.
The Wizard for Creating a Skeletal BOCR Model

• Start the wizard by selecting File>New from the main screen and enter a name for the new file, for example: New Car Decision.sdmod.

• Double-click the BOCR Full Template icon

BOCR Wizard (cont’d)

1. Select the merits you want in your model, typically all four are included for a BOCR model, and click Next.

2. Type in your control criteria (press Enter to add each one) then click Done and Next.
**BOCR Wizard (cont’d)**

3. Type in your alternative cars (press Enter to add) and click Done and Next

![Alternative Cars Input Screen](image)

4. Click Finish and wait for the wizard to build the BOCR structure.

![Finish Wizard Confirmation Screen](image)

5. Choose close current model to keep on with the creation of the BOCR!

6. Save as soon as the model is created

---

**BOCR Wizard Top Network**

- Top level of the BOCR model produced by the wizard.
- The merit nodes are numbered because SuperDecisions arranges elements alphabetically in its supermatrix data structure and formulas and we want BO and CR to be next to each other.
- The name of the model is *New Car Decision model* and the title bar shows it is formulaic indicating the results from the subnets are combined using formulas.

![BOCR Wizard Top Network Diagram](image)

**Tip:** To manually create a subnet for a node, right-click it to get its node menu and select Make/show subnetwork.
Control Criteria Hierarchies

4 Control Criteria subnetworks are created, one for each of the BOCR nodes.
• They contain hierarchies prepared by the Wizard with the control criteria you entered in the process. You must enter the pairwise comparisons.
• The title bar has breadcrumbs that specify which node the subnet belongs to.

Tip: When making the comparisons, for example, you ask “Which criterion can cause more risk?” The riskiest should end up with the highest priority.
The Bottom Level Alternative Subnets

- Twelve third level (or bottom level) Alternative subnets are created by the wizard, 3 for the control criteria nodes in the second level subnets.
- Each contains a cluster of the alternatives you entered in the wizard.
- You must complete each subnet by adding appropriate clusters, nodes and links.

Formulas

- Additive:
  - \( bB + oO + cC - rR \) (the wizard automatically assigns this one).
- Multiplicative:
  - \( BO/CR \)
- Probabilistic:
  - \( bB + c(1-C) + oO + r(1-R) \)
- User-defined formula
  - the user can input their own formula
- If no formula is defined
  - for each node that has a subnet, the vector of alternatives coming from its subnet is multiplied by the priority of the node. The vectors for all the nodes with subsets are weighted, added and normalized.
- The terms \( b, o, c \) and \( r \) are the priorities of the merit nodes, the \( B, O, C, R \) terms are priority vectors of the alternatives being passed up from the attached subnets.
**Which Formula Should I Use?**

- Use the **Additive** (negative) formula for the **best long term alternative**.
  - It is automatically assigned if the BOCR wizard was used.
  - Use this formula for **sensitivity** studies.
- Use the **Multiplicative** formula for the **best short-term alternative**.
  - It is not possible to perform sensitivity studies with this formula because of the way the constants are combined. All the lines are straight.

In practice one usually looks at both. Often the same alternative is ranked first, but not always.

- Use the **Probabilistic** formula in predictive models.

---

**Rules about Formulas**

- Formulas can be changed from one to the other in any multi-level model.
- Select the Design>Add/Edit Formula command and choose the one you want.
- The only thing that changes are the synthesis results (Computations>Synthesize) in the top network.
- You can try out as many different ones as you like – only the final synthesis results will be affected.
- As a general rule formulas are used only in the main network. When there is a formula in place, the word Formulaic appears in the title bar of the network.
- The multiplicative formula gives only positive results; the Additive (negative) and Probabilistic formula can end up with some negative values.
How Results are Passed up through the Levels to the Top Network

• Results are synthesized for each of the bottom level Alternative subnets resulting in a priority vector for the alternatives in each case.
• The Ideal column from each of them is multiplied by its control criterion priority in the second level.
• The synthesis command sums them and normalizes the sum.
• The Raw vectors from the synthesized alternative vectors in the control criterion subnets are combined in the main level using the formula in place there.

Sample BOCR Model:
Outsourcing IT

• The following slides demonstrate a typical model: BOCR_Outsourcing_IT.sdmod.
  – The SuperDecisions software model, PowerPoint slides and a report are also available.
• The first step in building any model is to decide from whose perspective you are making the decision.
  – The decision makers here are the management of a major US corporation deciding whether or not to outsource the development of their Information Technology (IT) to another country.
• The alternatives are:
  – 1) Outsource all IT development,
  – 2) Outsource the design and programming phases;
  – 3) Do not outsource.
**BOCR Outsourcing IT Decision**

- Open the sample model for the BOCR tutorial *BOCR Outsourcing IT Model.sdm*.
- The main network and all the subnets are in the main window, and you access them by
  - double clicking their name in the Network Structure section or
  - single clicking the pin icon on the corresponding node.

Each of the Merit nodes has a starting priority of 0.25.

**Customized Control Criteria**

- Control criteria subnets created by the wizard in the second level have a hierarchical structure and all contain the same control criteria.
- You can change the names, add and delete as you like.
- Remember to create an Alternative subnet if you add new control criteria that has the same Alternative cluster as the ones created by the wizard.
- Remember to check that the links and comparisons are complete in the hierarchy if you change anything.
- In this model the control criteria have been customized.
**Benefits Control Hierarchy**

**Subnet**
- Double click the 1.Benefits merit node on the left to get into the subnet shown here: *Subnet under 1.Benefits*.
- Pairwise compare the control criteria nodes to obtain the priorities shown below the nodes.

To return to the main screen: Double Click Main Network on the left side section “Network structure”

Note: A subnet is always labelled with the node it is attached to in the network above – in this case it is 1.Benefits

---

**Opportunities Control Hierarchy**

- Double-click the 2.Opportunities merit node in the Model Structure to get into its subnet shown below.
- The Customer-related node was pairwise compared with the Economic node to determine their priorities with respect to Opportunities.
- As you might expect the Economic opportunities were most important here.

Priorities established through pairwise comparing
Costs Control Hierarchy

Risks Control Hierarchy
**Decision Subnets**

- The Wizard will have created an Alternatives subnet for each control criterion with a cluster named Alternatives that contains the alternative nodes, but is otherwise empty.
- Finish the structure by creating clusters and nodes for relevant factors and linking them.
- The Alternative subnets are usually an ANP structure with feedback (links from the alternatives to the factors) and perhaps inner dependence (links from a node in a cluster to other nodes in the same cluster).

**ANP Versus AHP Structures**

- The SuperDecisions software handles multiple networks structured of nodes, organized into clusters, with links among the nodes.
- The data structure in each network is the supermatrix of priorities (unweighted, weighted and limit).
- **AHP hierarchical structures** – The links go one way, from the top down, with priorities being distributed downwards.
- **ANP network structures** – Links go from a parent node in a cluster to its children nodes in another cluster (or in its own) to form a pairwise comparison group. A parent node can have children in several different clusters (forming different pairwise comparison groups.) It is called Outer dependence if they are in another cluster, Inner dependence if in the same cluster.
- Unlike in human families, a parent node can have children in different clusters.

*Tip: To make the links pick a parent node and go cluster by cluster to see if the pairwise comparison questions make sense to link to children there.*
Example of a Decision Subnet

• There are a total of 8 Alternative subnets in the bottom level.
• Initially they are all the same, containing only the cluster of Alternatives.
• Relevant clusters and factors must be added and linked.
• The Alternative subnet currently in view is the Benefits>Economic Alternative subnet as indicated by the “breadcrumbs” trail.

Add Clusters, Nodes and Links
Pairwise Comparing in an ANP subnet

- Making pairwise comparisons is the same as usual.
  - For example, in the Benefits>Economic subnet, the Outsource All alternative is linked to the criteria in the Operational cluster.
- The question is: “What is the more important economic benefit from Outsourcing All: ‘Control/influence’ or ‘Fast time to market’?
- It seems clear that Fast-time-to-market is the more important reason for Outsource All.
- The results are priority vectors (or profiles) of the importance of the criteria for each alternative.

Synthesizing to get Results

- Results for each Alternatives subnet are obtained from the Limit Supermatrix. Its values are the Raw Values in the Synthesize command. (Computations>Synthesize)
- The Computations>Synthesize command.
Combining Decision Subnet Priorities

- Priorities in a BOCR model are computed from the bottom up.
- The two subnets belonging to the Benefits control hierarchy are combined by weighting their Ideal synthesis values by their respective control criteria priorities and adding.

### Combined results in the Benefits Decision Subnet

<table>
<thead>
<tr>
<th>Alternatives</th>
<th>Benefits Economic (0.83333)</th>
<th>Benefits Technological (0.16667)</th>
<th>Weighted Sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Outsource all application development</td>
<td>1.000000</td>
<td>1.000000</td>
<td>1.000000</td>
</tr>
<tr>
<td>2 Outsource the design and programming phases</td>
<td>0.276642</td>
<td>1.000000</td>
<td>0.397204</td>
</tr>
<tr>
<td>3 Do not outsource any application development work</td>
<td>0.159746</td>
<td>0.266934</td>
<td>0.177611</td>
</tr>
</tbody>
</table>

- The Raw results for Benefits shown from SD match our combined results for Benefits in the table on the left.
- It happens that the Ideals are the same as the Raw numbers in this model, but this is not always the case.
- Use the Raw numbers.
Where do Synthesis Results come from?

- Synthesis results are calculated for each network.
- Overall results are calculated by starting from the bottom and passing the results to networks above until you reach the top where the results are combined using a formula.
- Results are first synthesized for each of the bottom level Alternative subnets.
- The Raw values in the synthesis come from the Limit Matrix.
- The Normals and Ideals are calculated from the Raw values.
- To get the Normals sum the raw values and divide each by the sum.
- The Ideals are calculated by dividing each of the raw values by the largest of them.

Synthesizing Alternative Priority Vectors in a BOCR model

- For any network that contains a cluster of Alternatives, whether it be a model with a single network, or a bottom level Alternatives subnet in a complex model, Synthesis results are obtained from the raw values in the supermatrix.
- The Ideals and Normals are computed from the Raw values.
- In a BOCR model the Ideal values are passed up from the bottom level Alternative networks, multiplied by the control criteria priorities, added and normalized for the control criterion network synthesis.
- The raw values are passed up to the main network, weighted by the priority of the node to which the subnet is attached and combined using a formula.

Why use the Raw values instead of the Ideals? The Raw values maintain more information about relative value when the same Alternative is not the Ideal in the bottom level subnets.
Combined Alternative subnet synthesis
raw values for the 4 BOCR Subnets

<table>
<thead>
<tr>
<th>Alternatives</th>
<th>Positive</th>
<th>Negative</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Benefits</td>
<td>Oppor</td>
</tr>
<tr>
<td>1 Outsource all application development work</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2 Outsource the design and programming phases</td>
<td>0.397</td>
<td>0.827</td>
</tr>
<tr>
<td>3 Do not outsource any application development work</td>
<td>0.177</td>
<td>0.490</td>
</tr>
</tbody>
</table>

Adding the Strategic Criteria

- Build a hierarchy of strategic criteria in the main model and obtain the priorities by pairwise comparing them.
- Weight the BOCR by rating the top alternative for each merit against the Strategic Criteria
Rating the BOCR

- What is the highest valued alternative for Benefits?
- To determine what it is synthesize in the Benefits control subnet which will rank the Alternatives under Benefits.
- Keep that highest alternative in mind and perform ratings across the Benefits row as to how it impacts the strategic criteria.
- Repeat across the Opportunities row for Opportunities' highest valued alternative...and so on.

- For Costs and Risks the highest valued alternative will be the worst one so you will be rating by asking the question “How does this worst alternative for Costs (Risks) impact the strategic criteria?”

<table>
<thead>
<tr>
<th>Benefits</th>
<th>1. Financial Available (x)</th>
<th>2. Availability of expertise (A)</th>
<th>3. Flexibility of system (F)</th>
<th>4. Time-to-market (T)</th>
<th>5. Media perception (M)</th>
<th>2. Share of voice (S)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Opportunities</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Costs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Risks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Final Step is to Combine the BOCR Using a Formula

1. Additive negative formula – generally best for long term results: bB+oO-cC-rR


To change the formula use the Design > formula command.
This is the Additive (negative) formula as the software expresses it

Performing Sensitivity on the BOCR Nodes

- Select the Additive (negative) formula using the Design>Sensitivity command
- Select Computations>Sensitivity
- Select Edit>Independent Variable
- You need to select the correct Independent Variable (to do sensitivity for the Risks, for example, choose Risks)
- Click on the node “Priority: 1 Availability of …” to select it, then select Edit to get to the Edit Parameter dialogue box. Change the Wrt Node to Risks.
Parameter Settings for Risks Sensitivity

• In the Edit Parameter dialogue box set the Parameter Type to 0 for priorities and the Network to 0 for the top-level network (it is the bottom position as shown below – there is no name on it) and select Benefits for the Wrt (with respect to) Node.

Display the Sensitivity Graph

• Click the Done button then the Update button to display the graph shown below.

• As the priority of Risk increases above about 40% the best option changes from Outsource All to Do Not Outsource.
Investigate Sensitivity for the other nodes:
Benefits and Costs shown below

The Analytical Hierarchy Process (AHP)
“The AHP has revolutionized how we resolve complex decision problems.”

2008 Informs Impact Prize to
Thomas L. Saaty

Steven Graves – Massachusetts Institute
of Technology Committee Chair